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Introduction 
 
The purpose of this manual is to provide instruction and guidance in using the product 
"ECR NF Cost Report," which contains the Medicaid Cost Report forms submitted 
annually by all participating Virginia Medicaid Multi-Level Nursing Facilities.  Also 
included are the Certification and Verification letters which must be submitted with the 
cost report itself. 
 
In addition, this product contains two other important functions.  The first is a validation 
routine that helps prevent data entry errors or omissions of essential data items.  The 
second is a routine that creates an electronic data file that can be used to automatically 
enter the cost report data into the DMAS database.  The "How To" for performing these 
functions and other procedures are explained in this document. 
 
The ECR NF Cost Report Product was developed using Microsoft Excel.    However, one 
does not need to be proficient in using Excel to be able to use the ECR NF Cost Report 
Product.  It would probably help, but is not necessary.  You should be able to complete 
the cost report forms and create the electronic data file by simply following the 
instructions in this document. 
 

Software  Requirements: 
 
1. Microsoft Excel 2003 or higher. 
 
2. Access to your facility's GoFileRoom account. 
 
3. WEB Security settings allowing Pop-Ups and designating GoFileRoom as a 
 Trusted Site.  (See the GoFileRoom Basic User's Guide for specific instructions). 
 
4. The Adobe Add-In, which can be downloaded from GoFileRoom, on the initial 
 Sign-On screen. 
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Getting Started 
 
The first step is to download the ECR NF Cost Report Product.  The software, which is 
an Excel file, is stored in GoFileRoom, in the Library Drawer, under Cost Reporting 
Forms. 
 

Obtaining the ECR Software: 
 
To obtain the software, 
 
1. Sign On to GoFileRoom 
 

 
 
2. Click the Library Drawer 
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3. Click the "Search" button. 
 
4. When the next screen appears, use the pull down menu for the first Index entry 
 and choose "Cost Report Forms." 
 
 
 

  



          Page  4

 
 
 
5. Click the "Search" button at the bottom of the screen.  When the list of documents  
 is returned, look for the ECR NF Cost Report.  Make sure you retrieve the version  
 appropriate for the State Fisca Year in t=]which your own FYE falls. 
 
 Example:  Click on the ECR NF Cost Report 09-10A if the FYE of the cost report  
 your are filing falls between 06/30/2009 and 05/31/2010. 
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6. Check the checkbox beside the Entry. Then Right Click the entry.  Choose 
 "Export" from the menu options. 
 

  



          Page  6

 
 
7. GoFileRoom will prompt you to choose a destination for the Export (or 

Download).   Once you have chosen a folder in which to save your download, be 
sure to also change the e file name.  Otherwise, GofileRoom will automatically 
fill in the subdirectory name as the file name.    

  
You may store the ECR NF Cost Report on either your hard drive or on a network 
drive.  In addition, you may name it any valid Excel Name.  We suggest ECR NF 
cost Report-9999999999 where the '9's are your NPI number.  You may have 
several copies of the ECR NF Cost Report, one for each facility.   
 
Note that the Excel file is approximately 2.5 MB is size, and the download may 
take a couple minutes to complete. 

Obtaining the CMS-INPUT File 
 
The CMS-INPUT worksheet is a stand-alone version of one of the sheets within the ECR 
NF Cost Report workbook.  You may copy and use the CMS-INPUT stand-alone version 
to collect and save data from the CMS reports or your own books.  You may create your 
links from the Stand-Alone version to any proprietary software you may use in your 
shop.  Later, when you are ready to file your Medicaid Cost Report, you may paste the 
data into the CMS-INPUT SHEET of the ECR NF Cost Report (instructions give later). 
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To obtain a copy of the CMS-INPUT worksheet, go to the Library Drawer of 
GoFileRoom, choose Cost Reporting Forms, and follow the steps for exporting, as 
described in the previous section (Obtaining the ECR Software.) 
  

Obtaining the Input Data File: 
 
DMAS has prepared an input data file for each provider's fiscal year just ended.  The file 
contains data that will be needed to pre-populate many cells in the ECR NF Cost Report.   
Examples are: 
 
RS Means Data for Schedule R 
All R-1 Lines from the prior year's Cost Report 
Prior Year Semi-Annual Rates and Rate Period Dates 
Schedule H Ceilings, Inflation Factors and  Case Mix Index  Data  
Schedule J Payments, Charges and Days from MR32A Reports 
Schedule C Medicaid Ancillary Charges from MR32A Report. 
 
The data file is a text file (.TXT) and if stored in the individual provider's GoFileRoom 
Account.  Below are the Index Values needed to retrieve your file 
 
Drawer = DMAS-CG 
Facility Name = Your Facility's Name 
Provider No = Your Medicaid Provider ID 
Parent or Owner = Your Parent Corporation Name (or your facility name if individually  
          owned) 
 File Section = "REPORTS PBDMAS" 
Document Type = "ECR DATA" 
Description = "DMAS INPUT DATA.TXT" 
Period Ending = your FYE 
 
You need to export this file to your PC or  Network drive (i.e. check the box beside the 
file name, then Right Click and choose Export). 
 
After the export is complete, you may close GofileRoom.  Make sure you click the small 
"Logoff" button at the top right corner of the GoFileRoom Login screen.   
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Security Requirements: 
 
In order to run the ECR NF Cost Report, you must have your Excel Macros Security 
Settings on either Medium Security or Low Security.  To do this: 
 
Click Tools, then Options: 
 

 
 
 Choose the Security Settings Tab 
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 Click the Macros Security button on the bottom. 
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Click either Medium or Low Security. 
 

 
 
Click OK 
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Opening ECR NF Cost Report 
 
It is recommended that you first open Excel, then Click File, Open, find the folder/ drive 
in which you designated when you downloaded the software, then click on ECR NF Cost 
Report.xls. It is particularly important that you OPEN in this manner, rather than going 
through Windows Explorer, when you are ready to generate your electronic                          
data file.  The electronic file will be created and saved in the folder in which you are 
currently working, if you follow these OPEN instructions.  Otherwise,. the file will be 
created in "My Document". 
 
Open Excel Screen:  Example 
Click the "File" Menu. 
 

 
 
On the File Menu, Click "Open" 
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Use your pointer to find the Drive / Folder where the ECR software is stored.   
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Highlight the file and click Open. 
 
 
The next screen or sheet that you should see will be a dialog box issued by Excel.  It is 
asking you to "Enable Macros.”  See Below 
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Open spreadsheet first screen 

 
 
Click the "Enable Macros" button.   
 
Note:  If you do not enable macros, most of the functionality will be lost. 
 
The spreadsheet has been programmed to open, each time, at the Instructions Sheet.  (See 
below). 
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Instructions sheet  upon entering 

 
 
 
The date in the top right corner indicates the date of the last update to the instructions.  If 
you have used the ECR NF Cost Report since the last update and are familiar with the 
process, you may proceed by clicking either of the commands buttons at the top of the 
screen, as appropriate. 
 
If you click the "Continue" button , you will go directly to Schedule A-1, where you can 
manually enter the cost report identifying information such as Facility Name, Medicaid 
Provider ID, and Reporting Period Begins and Ends.  This is the ONLY place you enter 
this data.  The values you enter here are carried throughout the various worksheets in the 
workbook.  Actually, the Provider Number and Fiscal Year Ends as well as the Facility 
Name will be automatically loaded in when you insert your DMAS INPUT DATA file, 
explained later.  You can, however, change the values on Schedule A-1, if applicable. 
 
If you click the "Worksheets Menu" button, a list of all possible worksheets will be 
displayed.     
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Navigation 

Navigating within a Single Worksheet 
 
 
In general, on all the worksheets, only a few cells (or slots) can be modified.  These are 
colored blue on your screen.  The Tab key will move you from one modifiable cell to the 
next available modifiable cell. All other cells are protected against update and selection.  
You may also click with your mouse directly into the cell you wish to modify.  If the cell 
is not a valid data entry cell, you will not be able to select or modify the field.  The 
Currently active cell is the one that is framed in a dark box.   
 
If you wish to move backward through the unprotected cells of a worksheet, use the Shift 
plus Tab keys simultaneously. 
 
If the particular worksheet (or Schedule) you are currently working on is too large to be 
fully displayed on the screen, you may need to use the vertical and / or horizontal scroll 
bars to slide to the left / right or up / down. 
 
By clicking the Right Arrow in the Horizontal scroll bar (located in the bottom right 
corner of the screen), you can slide to right and see the entire width of the lines. 
 
By clicking the Down Arrow on the Vertical scroll bar, (located on the right side of the 
screen), you can see the bottom portion of this form which does not appear when you first 
enter the Schedule. 
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Schedule A-1 after scrolling Down and Right. 

 
 
 
One other way to scroll up or down or left or right is to tab through the unprotected cells.  
If you are on the Last unprotected cell that is displayed on the screen, tabbing to the next 
cell will cause the screen to scroll down, if, of course, there is another unprotected cell on 
the worksheet.  If there is not another modifiable cell, you will need to use the scroll bars 
to see the remainder of the worksheet. 
 
On all worksheets, you can return to the top of the worksheet by clicking Control + 
Home. 
 

Navigating  summary 
 1.  Tab to move to the next unprotected cell. 
 2.  Shift Plus Tab to move backward to the previous unprotected cell. 
 3.  Control Plus Home  to go to the top of the spreadsheet (Cell A1) 
 4.  Use Vertical and or horizontal scroll bars to view protected area that may not  
                 be visible on your screen. 
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Navigating from Schedule to Schedule 
 
There are many Schedules (about 20) included in the Medicaid Nursing Facility Cost 
Report package.  Each Schedule is defined on a separate Worksheet within the 
Workbook.  The various Schedules (or worksheets) are listed as folder tabs at the bottom 
of the screen.  They are not all visible at once.  Where the focus is at any given time 
within the workbook determines which worksheet tabs are displayed at the bottom of the 
screen.  Sometimes you may need to click the right or left arrow on the Worksheet 
Scrollbar (located on the bottom LEFT side of the screen) to see more worksheet tabs.  If 
you are an experienced Excel user, you may want to click on the desired tab to go to that 
worksheet.  However, we have built in a much easier way. 
 
At the top of each Worksheet there are 2 buttons. 
 
 1. A yellow rectangular button labeled  
  "Print Options & Submit ECR Menu" 
 
 2. A peach rectangular button labeled "Worksheets Menu" 
 
On Schedule A-1 only, there is a third button that will display the ECR  
Instructions sheet. 
 
The Worksheet Menu  button if the button you will probably use most frequently.  When 
this button is clicked, a menu of worksheets will appear (See below). 
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Schedule A-1 after clicking the "Worksheet Menus" button 

 
 
 
Simply click on the Worksheet you wish to enter next.  For example, by clicking A-3, 
Worksheet A-3 appears. 
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Schedule A-3 as entered from the Worksheet Menu 
 

 
 
When you have finished with A-3, click the Worksheet Menu button again to invoke the 
Worksheets Menu, and choose the one you want to go to next. 
 
The two menu buttons appear at the top of each spreadsheet in the workbook. 
 
If you are further down in the worksheet (i.e. if you have scrolled down using the vertical 
scroll bar), you may not see the buttons.  They are there.  Simply scroll up again to the 
top of the worksheet to see the two menu buttons OR press Control + Home to go to the 
top, Position A1. 
 
For example, in the next illustration, the middle portion of Schedule H is showing on the 
screen.  You cannot see the Provider Information or the two Menu Buttons. 
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Middle of Schedule H showing that the Navigation Buttons are not visible. 
 

 
 
 
By scrolling up, using the vertical scroll bar or pressing Control + Home, the buttons 
come into view.  (See next illustration). 
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Top of Schedule H after scrolling up (or Control Plus Home) 
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Loading the DMAS INPUT DATA File: 
 
As explained earlier, DMAS has prepared a text file to be used as input to the ECR NF 
Cost Report.  The file contains a possible 295 items that will be automatically copied into 
the appropriate worksheet cells.  You do not have to use the input file, of course; and if 
you do use it, you may still change the values of data automatically filled in by the "Copy 
Data to Worksheets" function. 
 
To load the data into your ECR NF Cost Report, first click the Worksheets Menu button 
and choose "DMAS-INP-FILE". 
 

 
 
Next Click File – Open, and choose the text file you exported from GoFileRoom—
DMAS INPUT DATA.TXT.  Make sure the "Files of Type" is set to "All Files" 
 
Once you click to open DMAS INPUT DATA.TXT , the following screen should appear. 
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Accept the defaulted options (Delimited, Tab as Delimiter, and General Formatting) and 
click "Finish". 
 
Note:  Sometimes Excel opens the file as a "Fixed Width" file. If the default is "Fixed 
Width", click the "Next" button and verify that there is a divider between Columns A and 
B and between Columns B and C.  The divider between A and B should come 
immediately before the "F" in "Facility Name," which is the description for row 1.  .  The 
divider between B and C should come immediately before the first character of the 
facility's name as shown on row 1.   You will probably need to use the horizontal scroll 
bar to move across the row and display the beginning of column C.  
 
Hint:  It may help you to open the file in Note Pad first so that you can clearly see that the 
file is divided into 3 distinct columns.  
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You will need to widen columns B and C to make the file more readable. 
 
The worksheet contains 3 columns.  Column A contains the row number.  These should 
be consecutive  from 1 to 295 at present (February 2009).  If any rows are missing or out 
of order, the file should not be used to load data into your ECR. 
 
Column B contains a description of the item.  Column C contains the item's value.  It is 
Column C only that you will copy into your ECR NF Cost Report. 
 
Highlight Column C Rows 1 – 295. 
Then click the Edit Menu – Copy. 
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Change windows and go to the ECR NF Cost Report, DMAS-INP-FILE Worksheet.  
Place your cursor in row 1 of Column c then  click 
 
 Edit 
 
 Paste Special 
 
 Click the "Values" button 
 
 Click OK. 
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Then click the button labeled "Copy Data to Worksheets".  You will see a sort-of "light 
show", meaning lots of flickering and flitting from sheet to sheet.  When the copy 
completes, the focus will be on Worksheet A-1, Fiscal Year End cell.   
 
You may then return (switch windows again) to the DMAS INPUT DATA.TXT,   Press 
Escape then close the file.  There is no need to Save Changes.  
 
At this point, you may begin entering your cost report data into the remaining blue cells, 
the cells that were not populated by the DMAS-INP-File.  
 

Loading the CMS-INPUT Data: 
 
If you are using the stand-alone CMS-INPUT sheet to collect data that will be included in 
the cost report,  open the stand-alone version of CMS-INPUT, the one that contains your 
data.   
 

 
 
Highlight Column E, then click Edit Copy (or Right Click and Copy, or Control + c) 
 
Change windows and go to the ECR NF Cost Report.  Within the ECR NF Cost Report, 
choose Worksheets Menu option "CMS-Input" 
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Place your cursor on Row 1 Col. E.  Click the Edit Menu and choose Paste Special, 
Values Only.   
 
Once your data has been copied to the ECR, click the "Transfer" button on the right to 
transfer the data to the appropriate worksheets.   
 
Switch windows and close the stand-alone version of CMs-Input. 
 
Note:  As with the DMAS Input Data, once the data has been transferred to the apppriate 
worksheets, the values may be changed on the indivisual worksheets. 
 
 

 

Print Options & Submit ECR Menu 
 
By clicking the Yellow menu button labeled "Print Options & Submit ECR Menu", a 
window containing another menu will appear.(See below). 
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Validate ECR Data: 
 
 
The first button, validates the data and data formats, looking for missing "required" items, 
or data that is entered in and incorrect data format.   
 
If any errors are found, focus will be directed to the Validation Sheet, where a list of all 
errors will be available.  To correct the errors,  
 
 1 Place your cursor on the row listing the error, and then click the "GoTo"  
  Button.   
  
 2. This will take you directly to the specific worksheet / cell to be corrected. 
 
 3.  After correcting the item, click the Worksheet Menu and choose  
   "Validation Sheet.” 
 
 4. Move to the next error message row and repeat. 
 

NOTE:  The list of errors on the Validation Sheet still contains the error 
you just corrected.  The Validation Sheet is not refreshed until you click 
the "Create Electronic Cost Report" again. 
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Validation Results Example 

 
 
 
When all errors have been corrected, either Re-Click the "Validate ECR Data" ro verify 
all errors are corrected, or click the  "Create the Electronic Cost Report".   
 

Create the Electronic Cost Report: 
 
If there are NO remaining errors, the procedure will then create the following data file. 
 
 "E Cost Report Data.prn" 
 
The file is created on the drive / folder in which you are currently working, if you have 
opened the workbook in the recommended manner.  Otherwise, the file will be created in 
"My Documents". 
. 
 
The text file (the .prn file) is the Electronic Cost Report (ECR) file, the one that DMAS 
will use as input to load your cost report data into their database for processing.  This  
(E Cost Report Data.prn)  is the file that must be placed in GoFileRoom.   
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As this routine runs, you are presented with many questions.  Answer "YES" to all of 
them or click "OK" whichever is appropriate.  If you click "Cancel" or "No" the process 
will NOT complete successfully.  Below are some of the questions and messages that are 
issued during the "Create Electronic Cost Report” process. 
 
MSG.  
   # 

 
                       Message 

 
                             Explanation 

1 "You are going to be prompted to Save a 
File.  Please answer "Yes". 

This is simply an instructional 
message.  Click "OK" 

2 "A file with the name "E cost Report 
Data.prn" already exists.  Do you want to 
replace it?" 

This message, and the following one, 
will appear if you have run the 
"Create Electronic Cost Report" 
process previously and IF the output 
files are still in your current working 
directory. 
 
 Answer "Yes" to continue. 

4. "Do you want to save changes you made 
to E Cost Report Data.prn?" 

This message is issued when the 
"Close File" instruction is executed.  
Answer "Yes" 

7. "Do you want to save changes you made 
to E Cost Report Data.xls?” 

Same as above. 

 
The process is complete when focus returns to the ECR NF Cost Report, Schedule A-1. 
 
Important Note:   
 
During the "Create ECR Process" when Excel prompts you with question "Do you want 
to replace the existing file...," be sure to answer YES.  If you click "NO" you may be 
prompted with the statement such as "A Formula or Range with the name _cr.002 already 
exists.  Do you want to accept this name or change it?"  You may receive as many as 500 
such questions.  You will have to keep responding until all cells with Range or Formula 
names have been evaluated.  This occurs most probably if you have attempted to create 
the ECR twice and answered "No, Don't replace" both times without closing the ECR NF 
Cost Report.xls 
 
Another means of getting out of this situation is to press Control Alt Delete, Choose Task 
Manager, and Choose Excel.exe and then click "End Procedure Now."  You will, of 
course lose any changes you may have made since the last "Save" was issued. 
 
.  
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Print the Entire Cost Report 
 
Click the "Print Options & Submit ECR Menu" button to display the form shown below. 
 
"Print Options and Submit ECR Menu” 

 
 
"Set Print Size to 100%" will set the size of each worksheet to 100%.  This is what you 
will want if you are making a hard copy. 
 
"Set Print Options for GoFileRoom" will set the print size option to 50% on all sheets.   
Use this option before you print to GoFileRoom.  Otherwise, your Adobe copy of the cost 
report in GoFileRoom will be extremely large and virtually unreadable. 
 
"Print Entire Cost Report" will allow you to either produce a hard copy or print an Adobe 
copy of your cost report to your GoFileRoom account.  This will be your official Cost 
Report submission to DMAS.   
 
When you click the button, you have the option of "Preview" or "Print."   
 
If you "Print", you can either print to a printer OR change the Printer using the pull down 
menu and selecting "GoFileRoom." 
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Click Print, and then select the printer called "GoFileRoom". 
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Then click OK.  An Adobe file will be created in the background, and then the 
GoFileRoom Sign On screen will appear.  Sign On, then fill in the indexes and click 
Save.  Be aware that this entire process may take as long as 5 minutes, depending on 
internet traffic at the time.    
 
Note: In order to print to GoFileRoom, you must have first installed the Adobe 
Acrobat Add-In from the GoFileRoom start-up screen.  When you use the pull-
down Printer menu, if "GoFileRoom" does not appear as an option, then you have 
NOT installed the Adobe Add-In. 
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Sample: GoFileRoom screen with the indexes filled in. 

 
 
DMAS recommends that you name your Adobe file "PIRS 1090 ECR AS  FILED".  You 
may affix your NPI number, but it is not necessary. 
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The Output File (E Cost Report Data.prn) 
 
As stated earlier, the "Create Electronic Cost Report" procedure creates an output file— 
E Cost Report.prn.  These file IS written to the folder in which you were working at the 
time you issued the "Create ECR..." command. 
 
Note:  If you have not opened the ECR NF Cost  report.xls through Excel, your output 
file may be written to "My Documents".  Be sure to open Excel FIRST, then open the 
spreadsheet while within Excel. 
 
This is the file that MUST be transmitting into GoFileRoom.  It is the input file for the 
DMAS procedure that loads your Cost Report data in the DMAS database.   
 
To open the ".prn" file, use Notepad.  This is the Data Input File for the Oracle process 
that loads your cost report data into the DMAS database.  (See example below). 
 

 
 
The first item on each row is the Provider Medicaid ID.  Then comes an "!" and then the 
Fiscal Year End of the cost report.  These are the only two items you need to verify, and 
then only on the first line. 
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In addition, it is a good idea to verify that the Create Date of the E Cost report Data.prn is 
correct, the latest version, in other words.   
 
 
Transmitting the Data File: 
 
To transmit the E Cost Report Data.prn, follow these steps.  Do NOT write the file to 
GoFileRoom.  It will be UNUSABLE if you do so. 
 
 1.  Sign on to GoFileRoom 
 
 2.  Select the DMAS CG Drawer and Choose "Add Document" 
 
 3.  Fill in these index values: 
 
  a. Provider or Facility Name 
  b. Provider ID 
  c. Parent or Owner Name 
  d. File Section = "Cost Report Filings PBP" 
  e. Document Type = "Cost Report" 

f. Document Description = 
  "E COST REPORT DATA-9999999999.prn" 

  g. Period Ending = the Fiscal Year End of the Cost Report 
     being transmitted. 

  h. Date Added should be today's date. 
       . 
 
 4.  Click the Browse Button on the right side of the screen.   
      Then click the "Browse" button in the window that opens  
      at the top of your screen. 
 
 5.  Find the Text Data File  E Cost Report Data.PRN and click Open. 
 
      6.  Then click the GoFileroom Save button in the top portion of your screen.. 
 
The document should be saved and the index values cleared. 
 
Be sure to Log Off of GoFileRoom when you have completed these steps. 
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Below are screen prints taken when transmitting the cost report for Provider No. 
9999999999, Test NF One. 
 

 
 
 
Click Add: 
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Fill in the Indexes as shown below. 
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Click the Browse button on the right. 
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Then click "Browse" at the top of the screen. 
 
Then Select the E Cost Report Data.prn from the pull-down menu at the top of the screen.  
. 
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Click Open. 
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Click Save. 
 
When the transmission is complete, the index values will be cleared out. 
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Steps for Completing the Electronic Cost Report  
 
As with any programmed Excel spreadsheet or workbook, you may enter the data on your 
cost report schedules in any order you prefer.  However, some of the derived values may 
not be correct if one or more of the items needed to compute the value has not been 
entered yet.  On Schedule A-3, for example, all the calculated values will not be correct 
until one has entered data on Schedule A-4, J-2, and N.  Don't let this concern you while 
entering your source data. 
 
There are some rules, however, that one must follow in order to produce an accurate and 
complete Electronic Cost Report file.  These are listed below. 

Step 1 Open and Enable: 
 
Open the ECR NF Cost Report.xls workbook through Excel.  In other words, open Excel 
first, then click file Open, and click on the ECR NF Cost Report.xls. 
 
Click "Enable Macros" 
 

Step 2  Load the DMAS INPUT DATA.TXT and CMS-INPUT 
 
Using Excel, open the text file DMS INPUT DATA, that you exported from 
GoFileRoom.  Highlight Column C.  Copy and Paste Special  into Column C of the 
worksheet DMAS-INP-FILE of the ECR NF Cost Report.  Then click the "Copy Data to 
Worksheets" button. 
 
If you are using the CMS-INPUT stand-alone sheet to collect data, open the worksheet 
and copy the data in Column E to the worksheet within the ECR NF Cost Report 
workbook. 

Step 3 Enter and Verify: 
 
Enter all the source data.  Make sure the Provider Number, Name, and Period Begins and 
Period Ends are correct on Schedule A-1. 
 
Step 4 Validate the Data: 
 
Click the Printing and Submit ECR button and choose "Validate ECR Data".  The 
Validation Sheet will appear, listing all errors, if any.   
 
 Highlight the error message row. . 
 Click the Go To button. 
 Make your Change. 
 Click the "Navigate Worksheets" button and select the 
 Validate worksheet. 
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 Continue reviewing and correcting, if necessary 
 
If there are no errors, the Validation sheet will still appear, but with the message "No 
Exceptions Detected." 
. 
Step 5 Create the Electronic Cost Report:
 
Click the "Print Options & Submit ECR Menu" button, then select the "Create Electronic 
Cost report" button. 
 
If there are still errors, the Validation Sheet will be displayed once more, listing all 
remaining errors.   
 
If there are No errors, the electronic file will be created.  Answer "Yes" or "OK" to all 
system-issued questions during the Create procedure. 

Step 6 Verify the .prn File: 
 
Check the "E Cost Report Data.prn" file to make sure it has the correct Provider 
ID and fiscal year end date, at least on Line 1. 
 
Step 7 Print to GoFileRoom 
 
Print an Adobe copy of your cost Report to GoFileRoom.  Be sure to "Set Print Options 
to GoFileRoom" first.  Be sure to fill out the GoFileRoom index as instructed. 
 
Step 8 Transmit the Cost Report to GoFileRoom: 
 
Sign on to GoFileRoom.  Click the DMAS-CG Drawer and then click "Add." 
 
Follow the steps listed in "Transmitting the Cost Report" section. 
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Data Formats 
 
 
In general, the following rules apply.  Failure to adhere to these rules will stop the 
creation of the Electronic Cost Report.  The editing routine is expecting data to be in the 
format originally specified.  If you change the format in any of the unprotected cells, the 
edit may fail.   
 
General Rules: 
 
1. Provider Number 
  
 10 characters 
 All characters must be numeric 
 No spaces, hyphens or any other special characters 
 
2. All Date items such as Period Ends must be entered as "MM/DD/YYYY".  The 
 slash is required.  For example March 1, 2007 must be keyed as 03/01/2007. 
 
3. All per diem amounts such as Schedule H, Line 12, Direct Patient Care Ceiling,  
 must be keyed as 123.55.  The dollar sign is optional. 
 
4. Total amounts, which are usually in whole dollar format, should be entered as 
 111,333,555.  Comma is optional.   
 
 The entire amount cannot exceed $999,999,999, even though a couple of the 
 computed values may exceed this amount. 
 
 $ Sign is optional. 
 
5. Ratios, such as Schedule C cost to charge ratio, are usually computed to 6 
 positions after the decimal. 
 
6 "Factors," such as CMI Factor, RS Means Factor, allow only 4 places after 
 the decimal. 
 
7.  "Per Cent" is usually expected to be entered as a decimal number, i.e., the fraction 

that it represents. 
 
 Examples: 
 
 95 Per Cent should be keyed as .95 
 75.4 Per Cent should be keyed as .754 
 100 Percent is 1.0000 
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Exceptions and Special Cases: 
 
Note:  If you have questions about the expected format of a data item, while in the 
Schedule, Click View and Select Comments (or Alt + V, then C).  If there are any special 
instructions for items on the schedule, a comment box will appear by the item.  To 
remove the comments from view, simply click View then Comments again. 
 
 
Schedules E and F 
 
 Percent of Work Week and Percent of Ownership 
  Enter as a whole number with 2 positions after the decimal, if necessary. 
 
 Example:  95.32 means 95.32% 
                 100 means 100% 
 
 
Schedule H, Lines 9 and Line 19 Inflation Factors. 
 
 Key as 1 + the percentage amount. 
 
 Example   1.0340 represents an inflation rate of 3.4 per cent. 
 
 
Schedule R-1: 
 
 Year Acquired:  Key all 4 digits of the year. 
 
 Values from 1951 and 2050 are accepted. 
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Troubleshooting 
 
The following scenarios may occur if you omit an essential step or misunderstand one of 
the important instructions.  Don't panic.  Check below and see if your situation is listed.  
If so, try the suggested solution.  If you still have problems, call Clifton Gunderson for 
technical support. 
 
Situation 1:  Can't Find the File: 
 
I can't find my electronic file, E Cost Report Data.prn.  I saw it being created, but it's not 
in my working directory. 
 
Probable Cause: 
 
You probably did not open the ECR NF Cost Report as directed.  Your electronic file was 
probably created and stored in MY Documents. 
 
Solution: 
 
Look in My Documents.  If the file is not there, read the "Open" instructions in this 
manual.  Then try again to create your electronic cost report. 
 
 

Situation 2:  Buttons Do Not Work 
 
I click on the menu buttons and nothing happens: 
 
Probable Cause: 
 
You probably did not "Enable Macros" when you opened the ECR NF Cost Report. 
 
Solution: 
 
Close the workbook. Then Open it again.  This time click the "Enable Macros" button. 
 

Situation 3:  Print too small 
 
I printed my cost report and it is too small to read. 
 
Probable Cause: 
 
You probably forgot to click the button that says "Set Print Size to 100%". 
 
Solution: 



          Page  50

  

 
Go to the Printing and Submitting Menu.   Click the button that says "Set Print Size to 
100%".   
 
Then Click "Print Entire Cost Report". 
 

Situation 4:  I do not see the GoFileRoom Printer: 
 
I attempted to print to GoFileRoom, but the GoFileRoom did not appear in my pull down 
list of printers. 
 
Probable cause: 
 
You have not installed the Adobe Add-In from GoFileRoom. 
 
Solution: 
 
Sign On to GoFileRoom.  Install the Adobe Add-In. 
 
Retry printing to GoFileRoom: 
 
Situation 5:  Macros Will Not Enable. 
 
I clicked the "Enable Macros" button but Excel told me it couldn't enable them. 
 
Probable Cause: 
 
You have not set your security to Medium or Low in Excel.   
 
Solution: 
 
Follow the Security Instructions in this manual. 
 

Situation 6:  Cannot Eliminate Errors 
 
When I try to "Create the electronic Cost Report," I still get errors.  Some of them look 
all right to me. 
 
Probably Cause: 
 
You have probably changed the format in one or more of the unprotected fields.  The 
error-handling routine expects a certain format.  If you change it, the validation routine 
cannot properly interpret your values.   
 
Solution: 
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Read the "Formats" section.  Check the item in error and see if you have inadvertently 
changed the format to "Custom" or "Accounting" or some other type that is not 
acceptable for the item in error. 
 

Situation 7:  GoFileRoom Version Too Large 
 
I printed my cost report to GoFileRoom.  When I went into GoFileRoom and looked at it, 
the formatting had changed to twice or three times as big as it should be.  It is unreadable. 
 
Probable Cause: 
 
You did not first "Set the Print Option Size to GoFileRoom.” 
 
Solution: 
 
Go back into our ECR NF Cost Report, on the Printing and Submitting menu, first click 
the button "Set Print Size to GoFileRoom.”  Then click "Print Entire Cost Report.” 
 
You will probably need to alert DMAS that the first version of your cost report can be 
removed.   
 

Situation 8:  I am hung up on the Create Step and can't get out 
 
I am trying to create the Electronic Cost Report, but keep getting these weird questions 
like "The Formula or Range name _cr.026 already exists.  Do you want to accept this 
name in the new version?" 
 
Probable Cause: 
 
You probably clicked "No" instead of "Yes" when Excel asked you if you wanted to 
replace the file "E Cost Report Data.xls."   
 
Solution: 
 
Follow the instructions labeled "Important Note" at the end of the section "Creating the 
Electronic Cost Report."   There are detailed instructions on how to get out of the 
situation. 
 
Situation 9:  I have an NPI Error Message on the Validation 
Sheet: 
 
I have entered my NPI on Schedule A-1.  It is corect, but I can't get rid of the Error 
Message when I run the Validation Routine. 
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Probable Cause: 
 
You probably copied the NPI from a worksheet cell that was not defined the same way 
we have defined it in the ECR.  Then you "Pasted" the NPI in the A-1 cell, rather than 
typing it, which caused the format of the cell to be incorrect, based on the validation 
expectations. 
 
Solution: 
 
Open a blank worksheet.  (Simply File Open). 
 
With your cursor in any cell, click Format Menu,  and choose Cell. 
 
On the Format Window click the Number Tab. 
 
Choose "General" for the format type: 
 
Optional:  Click the Alignment Tab.  For Horizontal alignment, select "Left Indent.  This  
will cause your NPI number to left justify, which looks better when it prints. 
 
Click OK. 
 
Type in your NPI Number in the cell you just formatted. 
 
Highlight the cell, then click Edit, copy (or Control  + C) for copy. 
 
Go back to your ECR NF Cost Report.  In the Schedule A-1 NPI Cell, Control + V (or 
Edit, Paste).  Do NOT paste special this time, just Paste.   
 
This will change the format of  the NPI cell back to General, Left Aligned, which is what 
the validation routine expects.   
 
Re-run the Validation Routine. 
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